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A Simplified Guide 
to the Herbarium Database 

Version 2 – 8/2009 

The Herbarium Database was created for the Eckert Herbarium at Buffalo State College in Buffalo, New York. It 
is an application for Microsoft Access with programming by Peter Crane and with design and documentation by 
James Battaglia. Its creators had two goals. First, to make a database of the Eckert Herbarium's collection of 
vascular plants for posting on the internet. They also wanted to use those records to print labels, to conduct searches 
and to make simple reports. Considering its limited purposes and the fact that the application and its database 
constitute a single file, the authors think that it would be best employed in small herbaria. 

To use the Herbarium Database, your computer should be running Microsoft Office Professional and have 
sufficient memory to hold the file. This guide assumes you are using the Microsoft XP and Access 2007; procedures 
on the Microsoft Vista Operating System and on older versions of Access or XP may vary from those described 
here. This simplified guide will get you started. Because Access is a complex program, users are advised to obtain 
an operating manual for that program. 

On this downloadable version of the Herbarium Database, the header on Data Entry and Switchboard screens 
and on labels generated from the program read "Herbarium Database." Users can easily change the text in these 
headers and "personalize" the database. All data fields and their specifications can be redefined as easily. Consult a 
manual for Access. Also, early experience with the Herbarium Database saw the file grow very rapidly. In response, 
the designers activated the Compact and Repair function (under the MS Office Button/Options/Manage). This 
function (which is not the same as compression; read about it in Help) reduced the file significantly. You can 
activate Compact-Correct manually or set it to function at every closing of the database. Or not use it at all. 

We encourage users to contact the Eckert Herbarium about problems or errors with this application. We cannot 
guarantee any assistance, but we are interested in "bugs" that others encounter. Suggestions and other conversation 
are also welcome. 

DISCLAIMER: 
The Herbarium Database has not been field tested and users of this application do so at their own risk. The Eckert 
Herbarium and Buffalo State College are not responsible for any damage or loss to data, programs, networks, or 
hardware resulting from the use of the Herbarium Database. 
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Instructions for Basic Operations 
 
 
 

Open the Database 
 

IMPORTANT: READ FIRST! 
 
 
 
 
 

 
 
 

To open the database, double click ("click" means left click unless otherwise noted) on 
the file for the Herbarium Database. At the Eckert Herbarium, this file is located on the 
desk top in a folder called Eckert Herbarium Database. A Switchboard screen appears 
inside a larger Access screen. Click on the Herbarium Data Entry button and the first 
active record in the database appears. Alternatively, under Forms on the left side of the 
Access screen, click on Herbarium Entry Form. The record screen and the Switchboard 
are the only ones resident to the Herbarium Database; all others are Access/XP screens. 

 
Movement in the Database, Create a New Record, Record Bar 

 

Movement around a record is simple. To move the cursor to the next data field, press 
the Tab key. Avoid using Enter for this purpose. You can "jump" to any data field by 
placing the cursor in the desired field and clicking. 

You can move around the database by using the Record Bar found on the lower left 
side of the record. Clicking on the left facing triangle ()  moves you to the previous 
record. A click on the bar-left facing triangle (ψ)   moves you to the first record in the 
database. The right facing triangle () takes you to the next record, and the right facing 
triangle-bar (ψ) takes you to the last record in the database. 

Buttons on Home Tool Bar also allow movement around the database. Click on the 
Home Tab (upper left side of the Access screen) to bring up the Home Tool Bar. On the 
right end of the tool bar is the Find Box. Clicking on the downward pointing triangle () 
next to "Go to" opens a menu with the options for moving around the database. 

There are several ways to create a new record. On the Record Bar, clicking on the 
right facing triangle followed by a yellow asterisk (*) will create a new record. If you 
are on the last record in the database (or a subset of the database), clicking on the right 
facing triangle () creates a new record. On the Home Tool Bar, the Find Box (under the 
Go to menu) and the Record Box, each have a button for creating a new record. 

There are two boxes on the Record Bar. In the center of the Record Bar is the Current 
Record Box. The number after the word "of" shows the total number of records in the 
database (or a subset of selected records). The number before "of" is the number of the 
currently displayed record, numbered sequentially from the start of the database or a 
subset of selected records; this number does not necessarily correspond a value in any 
data field. The Search Box at the right of the Record Bar enables a type of search; see 
Query, Report Wizard, Search Box, Filter, Multiple Labels on page 5 – 6. 

 

When users open the database, a Security Warning box may appear notifying them that certain content in the 
application is insecure. If this warning appears, click on Options in the warning box and then click in the radio 
button to the left of the words "Enable this content." Click on OK. The warming box should disappear. Without 
enabling the content, the special features of the Herbarium Database will not function! 
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Herbarium Number 
 

When the Herbarium Database creates a new record, it automatically assigns it a 
unique number. This Herbarium Number is used to identify the record and you cannot 
alter it. It has its own data field. See Herbarium Number on pages 8 – 9. 

 
Save, Delete & Delete Records 

 

You can save a record at any time by typing Control S or by clicking on the Save 
button above the Home Tab on the upper left hand side of the Access screen. 
Alternatively, you can click on the Office Button and, when the drop-down menu 
appears, click on the Save button. Finally, on the Home Tab Tool Bar, the Record Box 
has a Save button. All of these options save your data without moving to another record. 
Please note that whenever you move to another record or close the database, the program 
automatically saves any additions or changes to the current record. Proofread your data 
carefully before saving or moving on to a different record. 

To delete the data in any data field, select the data and press the Delete key. 
To delete a record, click on the File menu and then click on Delete Record. Or on the 

Home Tool Bar in the Records Box, use the Delete menu. DELETE WITH CAUTION! 
When you delete a record, its data is irrecoverable and its herbarium number can no 
longer be accessed. 

 
Edit Records, Data Fields 

 

To edit a record, call up the record, make the changes in the appropriate data fields, 
and save or move to another record. 

The Herbarium Database has 21 data fields. Instructions on how these fields are used 
at the Eckert Herbarium are found in Procedures Specific to the Eckert Herbarium on 
pages 8 –15. 

 
Spell Check 

 

You should check all records for spelling before saving or printing. Unfortunately, 
Access 2007 no longer flags misspelled words with a red, squiggly underline. First, select 
the record by clicking in vertical bar immediately to the left of that record, or use the 
Select menu in the Find Box on the Home Tool Bar. If you do not select the record, the 
spell checker will check the entire database! In the Records Box on the Home Tool Bar, 
click on the spell checker. You can select multiple labels for spell checking by using a 
filter as explained in Query, Search Box, Report, Filter, Labels on pages 5 – 6. 

Users of the Herbarium Database in New York state might consider the installation of 
two spelling dictionaries available as free downloads from the New York Flora 
Association (nyflora.org). One file (plants.dic) contains the binomials for every taxa of 
vascular plant in New York state and the other file (authors.dic) the accepted 
abbreviations for their authors. At the Eckert Herbarium, we combined the two files into 
one and added it to Access and Word as a custom dictionary. This change greatly 
facilitates the use of the spell checker. 
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Buttons: Print This Label & Print Labels 
 

Two buttons at the bottom of the record allow you to print labels. To print an 
individual label, bring up the record and click on the Print This Label button. Preview 
and spell check all labels before printing!! Finish by clicking on one of the Print 
buttons accessed through the Office Button. 

You can print multiple labels, generally three per page, by using the Print Labels 
button. See the next section, Query, Report Wizard, Search Box, Filter, Multiple 
Labels. 

 
Query, Report Wizard, Search Box, Filter, Multiple Labels 

 

Query and Report Wizard are resident functions in Access. They are available on the 
Home Tab Tool Bar. Query is used to search the database. Report Wizard formats the 
records/data selected by a query (or any search function) into a report. At this time no one 
has tried to print such a report. Users will find these functions suitable for most purposes; 
however, an explanation of these functions is beyond the scope of this guide. Below are 
brief explanations of two other resident search functions: the Search Box and filters. 

The Search Box on the Record Bar finds all matches for the values entered there. For 
example, enter the word Rosa and press Enter. The first record with the value Rosa 
anywhere (including inside words) in any data field will appear; pressing Enter will bring 
up any additional instance of that value in that record or another record. 

 

 
 
 

 

Filters "filter' (i.e. search and select) the database for all records finding exact 
matches in any data field or any combination of data fields that you specify. For 
example, you can filter the database to find all records with the word Rosa in the data 
field for genus. Begin by clicking on the Clear the Filter button at the bottom of the 
record screen. On the Home Tab Tool Bar in the Sort and Filter Box, click on Advanced 
Filtering. On the drop-down menu, click on Filter by Form. A blank record appears. In 
the data field for Genus, enter Rosa. Now back on the Advanced Filtering drop-down 
menu, click on Apply Filter. Access will find all records that exactly match

You can filter for values in more than one data field. For example, you could enter 
Rosa in the data field for Genus and canina L. in the data field for Species/Authority. The 
filtered database will include only those specimens which exactly match the filter criteria; 
that is, specimens named Rosa canina L. By using resident functions in Access, you can 
save or print the filtered database, or create, save or print a report created from the 
filtered database. Consult an operating manual. To return to the complete database, click 

 the value 
Rosa in the data field for Genus. A record for a specimen in the genus Rosa will appear. 
Move to the next record; it too will be a record for the specimen in the genus Rosa; the 
database has been "filtered" for the genus Rosa and only those records are accessible. 
Note that the word Filtered appears on the Record Bar. The second number in the Current 
Record Box shows the total number of records in this subset of records. You can print a 
label for the visible record by clicking on the Print This Label button. Use the Print 
Labels button to print a label for every record selected with the filter. There is more 
information about printing labels below. 

Note: The instructions regarding Filters may be accurate for the XP OS only. 
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on the Clear the Filter button or on Clear Filter on the Advanced Filtering drop-down 
menu. Clicking on the word Filtered on the Record Bar returns you to the complete 
database but does not remove the filter criteria. 

More about printing multiple labels with filtering. Suppose you want to print labels for 
records with Herbarium Numbers 8–55. To begin, click on Clear the Filter. On the Home 
Tab Tool Bar, click on Advanced Filtering and then Filter by Form; a blank record will 
appear. In the data field for Herbarium Number, enter >7 and <56 (greater than 7 and less 
than 55; that is, 8–55). Note: the syntax is critical

You can use a filter to print labels for records not in any sequence or relationship. 
Initiate a filter. On the blank "filter" screen, in the data field for Herbarium Number, enter 
the Herbarium Numbers of the records you wish to print; separate each number with the 
word "or"; for example, 7 or 15 or 1397 or 1457. Again, syntax is 

. Click on Apply Filter. The record with 
Herbarium Number 8 will appear; on the Record Bar, it will be number 1 of 47 records. 
Click on Print Labels. The selected records will appear as labels on a print preview screen 
(up to three per screen). Proof the labels, edit as necessary, and print. 

critical

There are more filter functions available: for example, these numeric functions might 
be used with Herbarium Numbers. > = x will filter all records equal to or greater than x. < 
> x will filter all records not equal to x. < x filters for all values less than x, and > x filters 
for all values more than x. Consult a competent guide to Access for a lot more functions 
and instructions. 

. Click on Apply 
Filter. Access will select those only those records that have the values 7, 15, 1397 and 
1457 in the data field for Herbarium Number. Click on the Print Labels button. Proof 
before printing. When you are finished printing, be sure to click on the Clear the filter 
button. 

 
Annotations 

 

Part of herbarium maintenance is updating or correcting names on specimen sheets 
and in the database. Such changes are called Annotations. 

Common annotations include: corrections in spelling, corrections in determination (i.e. 
misidentification), revisions of the accepted name, and confirmations. In the data field for 
Annotation History, you can create a record of these changes. Users of the Eckert 
Herbarium will find instructions on how to handle the common annotations in 
Annotation History on pages 13 – 15. 

Annotations can be confusing! If you encounter one, consult a collections manager. 
 

Backup Data 
 

As a protection against the unintentional loss of part or all of the database, you should 
create a backup copy (-ies) of the database and update the backup copy (-ies) at the end 
of every session if new records were created or existing records edited. To create a 
backup copy, exit the Herbarium Database. Right click on file for the Herbarium 
Database. On the drop-down menu, click on Copy. Place the cursor on a location for the 
backup (at the Eckert Herbarium we use a folder named Eckert Herbarium DB Backup) 
and right click. Select Paste. If a copy of the Herbarium Database already exists in that 
folder, a Confirm File Replace Window appears. Select the yes radio button and finish as 
instructed. Backing up the database on an external storage device such as a flash drive 
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provides additional safety. To copy the database onto a flash drive, insert the drive into 
the proper port. At the Eckert Herbarium, the flash drive appear under My Computer (and 
not on the Desktop) as removable disk(F:). After copying the Herbarium Database file 
(see above), open the removable disk. Place the cursor over the documents folder and 
right click. Select Paste. Select yes if a Confirm File Replace Window appears. 

Remember that the Herbarium Database application and the database it creates are one 
file. As the database grows, the time needed to create a backup increases. Enabling the 
Compact/Repair function greatly reduces the size of the file. 
 

Exit the Database 
 

One way to exit the Herbarium Database is to bring up the Switchboard and click on 
Exit Access Altogether. Bring up the Switchboard by double clicking on Switchboard 
under Forms on the left side of the Access screen, or by clicking on any portion of the 
Switchboard not obscured by the current record. Alternatively, and more simply, exit the 
Herbarium Database and Access simultaneously by clicking on the x upper right hand 
corner of the Access screen. 
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Procedures Specific to the Eckert Herbarium 
 
 
 

Database Log 
 

Every session with the database should be documented in a Database Log. The 
Database Log is an Excel file located in the Eckert Herbarium Database folder. The 
record for each session should include four items: the name of the worker (format: first 
initial and last name, e. g. "J. Smith"), the date (numerical format: year/month, e.g. 
"2009/01"), the records created and/or edited identified by Herbarium Number (format: 
1563, 1674, 107) and the records left incomplete. For this last item, enter the Herbarium 
Number of each incomplete record followed by a reason why it is incomplete in 
parentheses. At the beginning of a work session, the user of the database should 
proof all the records entered or edited by the previous worker. Before closing a 
work session, the worker should proof all records on which he worked. 

 
Data Fields: General Instructions 

 

This section of the Simplified Guide contains information on how to employ the data 
fields at the Eckert Herbarium: what information goes in each field and how it is entered. 

Sources of information for a record include the collector’s notes (on a newspaper 
flimsy or from a field notebook) or an existing label. If you are working from an existing 
label, be sure that all the information on the label is entered somewhere in the record. 
Sometimes you may have to add information (e.g. add the name of a county or town) or 
make corrections (e.g. spelling). If you are unsure of what to enter or how to enter it, ask 
a collections manager for guidance. 

When entering data, the general rule is to use no abbreviations, even if the source uses 
abbreviations. There are exceptions which are always used. They include the terms USA 
in the data field for Country and in the data fields for Genus and Species/Authority, sp. 
(species), ssp. (subspecies), var. (variety), f. (form) and the standard abbreviations for the 
names of authors (e.g. L. for Linnaeus. Other uses of abbreviations are cited below. 

If you encounter an illegible word/phrase, enter "illegible word" in parentheses. For 
example, "growing in full sun on (illegible word)." Place unknown abbreviations in 
parentheses; for example, "near (unknown abbreviation – Tld.)." Uncertainty about a 
word or piece of data can be indicated by question mark; for example, "town of Hume?' 
or "growing on limestone? outcrop." Finally, set Access to use straight quotes (" "). 
 
1. Section: 
 

Click on the drop-down menu triangle () to see the four sections: vascular plants, 
mosses and liverworts, fungi, and lichens. Click on the one appropriate for the specimen. 
This data field does not print on the herbarium label. 
 
2. Herbarium Number: 
 

Every record in the database (and hence, every collection in the herbarium) is 
identified with a unique number, the Herbarium Number. The program automatically 
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assigns the Herbarium Number sequentially when it creates a new record. Do not enter 
any information in this field; press Tab to move the cursor to the Genus box. Copy the 
Herbarium Number on the specimen sheet in the blank following the stamped phrase 
Herbarium Number:________. Use this six digit format: 000021. Print neatly using an 
archival black ink pen or a lead pencil that makes a dark mark. Add the appropriate stamp 
to sheets that lack one; the preferred placement is in the upper right hand corner of the 
sheet. If you make a mistake in pen, paste a piece of mounting paper over the error and 
print the correct number on that. Errors in pencil should be erased and neatly reprinted. 
Labels created from this program, will have the Herbarium Number printed on them. 
Check that the number on the label and on the herbarium sheet are the same. 

Note that the database program does not include introductory zeroes for any 
Herbarium Number. The specimen with the Herbarium Number 000051 will appear as 
51. All manipulations of the database will use 51 and not 000051. 

Also note that several hundred specimens in the Eckert Herbarium have identification 
numbers stamped on their labels. These numbers are obsolete. In the data field for 
Comments, enter "formerly Herbarium Number - 000." 

 
 
 
 
 
 
 
 
 
 

3. Family 
 

Enter the family name. Always capitalize the first letter. For plants, all family names 
end in -aceae. While working with existing labels, you will find family names (such as 
Compositae) that do not end in -aceae. Such names are obsolete; use only the updated 
family names in the database. 

 
4. Genus: 
 

Enter the accepted name for the genus (see text box above). Always capitalize the first 
letter. If you are working with an existing label, check above that label for new or 
corrected names (printed in pencil or on a printed annotation label). If you are creating a 
record from field notes, simply use the accepted name. 
 

 
 
 
 
 

NOTE:READ BEFORE ENTERING DATA IN FIELD 3 AND 4. 
 

Before entering information in the Genus and Species/Authority data fields, consult the Integrated Taxonomic 
Information System (ITIS.gov) website to check if the name is spelled correctly and currently accepted. Simply 
click on the link under Favorites. Follow the directions on the first screen for a Quick Search. When conducting at 
search at ITIS, it is important to spell the search name correctly. Consult MADCapHorse to resolve spelling 
issues. If you find that the name is not accepted or is not spelled correctly and you are working from an existing 
specimen label, you must stop and make corrections on the herbarium sheet. See Annotation History on pages 13 – 
15. For future searches, it is critical that the name and authority be identical for all records of a taxon. If you 
are unsure, consult a collections manager. If you cannot resolve a question, leave the record incomplete and record 
that fact and the problem in the database log. 

NOTE: When you enter information into a data field, that information is printed in regular font on the record 
screen. When making labels, the genus and species/authority will print in bold italics. Standard usage, however, 
calls for genus and species in italics and all other terms in regular font. To our knowledge, Microsoft Access 2007 
does not allow more than one font per data field. Here’s an example of how a name should look. 
 

e.g. Hepatica nobilis var. obtusa (Pursh) Steyerm. 
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5. Species/Authority: 
 

Enter the accepted specific epithet (species name) and the authority. Never capitalize 
the first letter of the specific epithet. If the specimen is a subspecies, variety or form, 
enter the abbreviations ssp., var. or f. as appropriate, and then the name of the subspecies, 
variety or form and the authority. For example, the taxa sharp-lobed hepatica and round-
lobed hepatica are varieties of Hepatica nobilis: in the data field for specific 
epithet/authority enter "nobilis var. acutiloba (Pursh) Steyerm." and "nobilis var. obtusa 
(Pursh) Steyerm." respectively. Enter any other term included in the name not accounted 
for in the other boxes. 
 
6. Country: 
 

Press Tab and the program automatically enters USA. Enter the unabbreviated name 
of any other country manually. 

 
7. State: 
 

Press Tab and the program automatically enters New York. Enter the unabbreviated 
name of any other state or province manually. 
 
8. County: 
 

Click on the drop-down menu triangle () to reveal a menu with the names of the 
counties in western New York. Click on the appropriate name. For counties outside 
western New York or for sites in Canada, manually enter the county name or the name of 
the regional municipality. Use these formats respectively: Jefferson County and Regional 
Municipality of Niagara Falls. 

Users can add or delete the names of counties on the drop down menu. On the Menu 
of Objects, select Tables. Click on counties. Add new county names in the blank or select 
and delete existing names. Be sure to include the word county: e.g. Jefferson County. The 
program will automatically alphabetize the list of county names. 
 
 
 
 
9. Town/City/Village: 
 

Enter the town, city, village or Indian reservation; use this format: town of Otto, city 
of Olean, Tonawanda Indian Reservation. Reserve these terms for incorporated entities 
(i.e. places that have a government; e.g. the village of Williamsville). Other place names, 
even if they appear on a map, are entered in the next field. If this information is unknown, 
leave this field blank and enter "town/city/village unknown" in the data field for Notes. 
 
10. Place Name: 
 

Enter recognized place names like those for parks, neighborhoods, geographical 
features and unincorporated villages: e.g. Delaware Park, Johnson Falls, Counterfeiter’s 
Ledge, Tifft Nature Preserve, Snyder. For names of unincorporated communities, which 

 

The website New York State Regions and Counties Map and Visitors Guide (www.visitnewyorkstate.net/regions/) 
[See Favorites on the Eckert Herbarium web browser] provides valuable assistance with town and county names. 
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often serve as the name of a local post office, simply enter the name, e.g. Clarence 
Center, Mortons Corners. Follow the name with a comma. If there is no place name, 
leave this data field blank. 

 
11. Coordinates: 
 

Enter coordinates. Use this format converting from other formats if necessary: N 00° 
00' 00" W 00° 00' 00". Note the spacing. Make a degree sign by typing Alt 8. End this 
entry with a period. If you do not know the coordinates, leave this data field blank. 
 
12. Specifics of Location: 
 

More specific details on the collection site. List those details from general to specific. 
For example, "on south side of the trail from parking area along west side of the bog." If 
you entered coordinates in previous data field, follow this entry with a comma. If not, end 
with a period. 

 
13. Collegit: 
 

Enter the name of the collector. Use this format: J. Doe. Note the use of a single initial 
with a period rather than a first name, J. Doe (not John or J. H. Doe). To insure the 
completeness of future searches, enter a collector’s name the same way every time. 

If there is more than one collector, enter only the name of the primary collector or the 
name that comes first alphabetically. Enter the names of the other collectors in the data 
field for Notes. If the collector is not known, enter Collector unknown. 
 
14. Collection Number: 
 

Enter the collection number, if any. Use this format: 345. The collection number is 
always that of the primary collector. If there is no Collection Number, enter "s. n." 
 
15. Date of Collection: 
 

Enter the date of collection. In this data field, use a numerical format: year/month/day; 
for example, 2008/09/25 (2008 September 25). An unknown month and/or day is entered 
as 00; for example, 2008/00/00. To enter the collection, a specimen must dated at least to 
year. You may write the unabbreviated date in the data field for Comments or, if needed 
for clarity, in Notes. 
 
16. Habitat: 
 

Enter the community name (if known). Enter the names of associates beginning with 
the overstory and ending with the understory. Use the words on, under, with, and over as 
appropriate. Include information about soils, slope, aspect, moisture, soils, and light. For 
example: "limestone woodland, on well-drained rocky soil, under Acer nigrum, Acer 
saccharum, Sambucus racemosa, with Dryopteris marginalis, Cardamine concatenata.". If  
no habitat information is available, type Alt 1 "No information recorded" will appear. 
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17. Notes: 
 

Enter all the information that you want to appear on the herbarium label

 

 that does not 
fit elsewhere. Below are examples of types of data to enter in this field and on how to 
enter them. Try to enter them in the same order as they appear here; separate items with 
a semi-colon and note the spacing. 

Examples: Data Field for Notes 
 

The name(s) of the determiner, if different from the collector, and the date of 
determination; use this format: "determinavit - John Q. Doe, December 20, 2008." Enter 
"Determiner unknown," "date unknown" as appropriate. 

The names of the collectors if there are two or more. Use this format: "collegit - John 
Q. Doe, Alfred E. Newman, Peter F. Smith." The name of the primary collector comes 
first, the other names alphabetically by last name. If there is no primary collector, list the 
names alphabetically. 

Information about the morphology of the specimen; for example, "flowers white and 
sepals deeply cleft, stems glabrous" 

If a taxon is not native, enter "alien"; also terms such as naturalized, adventive, rare, 
abundant 

Any information from an original label that is not entered in another data field

If necessary for clarity, the unabbreviated date of collection: e.g. date of collection - 
September 9, 2009. 

. For 
example, "elevation – 1240 feet." 

Enter the ecozone or ecoregion. Ambitious workers can find this information on maps 
posted in the herbarium. Format: ecozone - Cattaraugus Highlands 

Enter the common name. Use MADCapHorse as a source for common names. 
Common names are not required. Use this format: "common name - day-lily" 

If a specimen is mounted on more than one sheet, identify the sheet in this way; sheet 
1 of 2 or sheet 2 of 2, etc. The individual sheets of such specimen should have sequential 
Herbarium Numbers but the same Collection Number. 

End the data field for Notes with a period. 
 
 
 
 
 
 
 

For the standard names of ecological communities in New York State, see Reschke, Carol. Ecological 
Communities of New York State, 2nd Edition, edited by Edinger, G. J. et al. January 2002; check the nyfa.org for 
updates. 

Note-Family number. The Eckert Herbarium formerly arranged the families according to Gray’s Manual of 
Botany (1950, 8th Edition, by Merrit L. Fernald). Each family was assigned a number, the family number, taken 
from that book. Many sheets in the Eckert Herbarium have the family number printed in pencil on the specimen 
sheet. Those numbers are now obsolete. In 2008, the Eckert Herbarium changed its organization (except for 
ferns, which use a more recent treatment) to that of the Manual of Vascular Plants of Northeastern United 
States and Adjacent Canada (1991, 2nd edition, by H. Gleason and A. Cronquist). It is no longer necessary to 
note family numbers in the database or on the specimen sheet. 
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18. Community Name: 
 

Enter the community name. A redundancy that may help with future searches. If 
unknown or undeterminable, leave blank. This data field is also available for redefinition. 
 
19. Annotation History: 

 
 
 

 
 

Here is how you handle the common types of annotation at the Eckert Herbarium. 
Enter records of annotations chronologically starting with the most recent. 

 
Correction of Spelling 

 

On a label, if a name or author is misspelled or partly missing, neatly print in pencil 
the correctly spelled, complete name above the original label. The corrector write his 
name (J. Doe) and date the correction. If the specimen has been databased, correct the 
spelling in the appropriate data fields. Make no other record of spelling changes. 

 
Corrections in Determination (Identification) 

 

If a specimen is misidentified, neatly print the correct name and authority above the 
label in pencil followed by the new determiner’s name or initials and the date. The 
specimen's name must also be corrected in the appropriate fields on the database record. 
Also, in the data field for Annotation History, write the erroneous name and authority, the 
name of the determiner and date of determination followed by the words "corrected to"; 
then write the correct name and authority, the name of the determiner and the date of 
determination. The names of both determiners and dates of determination are in 
parentheses. A simple example clarifies these instructions. In this example Claytonia 
caroliniana was erroneously identified as Claytonia virginica in 1978 and corrected in 
2005. Note the format: "Claytonia virginica L. (determinavit – A. Newman, November 
16, 1978) corrected to Claytonia caroliniana Michx. (determinavit – J. Doe, May 5, 
2005)." Use the phrases "Determiner unknown" and "Date unknown" as appropriate. 

 
Revision of the Accepted Name 

 

If a taxon has been revised and renamed, neatly print the accepted (new) name and 
authority in pencil above the original label. If the names are considered synonyms, the 
new name will be preceded by an = sign. Check synonymy at ITIS.gov. The name of the 
annotator and a date should follow the accepted name. The specimen's name must also be 
changed in the appropriate fields on the database record. In the data field for Annotation 
History, enter the unaccepted name and authority followed by "revised to" and then the 
accepted name and authority followed by the annotator’s name and the date of annotation 
in parentheses. Again, a simple example clarifies: "Smilacina racemosa (L.) Desf. revised 

Note: The data in the following fields below does not print on the herbarium label. 
 

Note: Most herbaria do not allow any writing on the specimen sheet or the original label. They make a special 
Annotation label that is glued above the original label on the specimen sheet. 
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to Maianthemum racemosum L. (annotator - J. Doe, September 25, 2008)." Use the 
phrases "Annotator unknown" and "Date unknown" as appropriate. 

 
Confirmation of Determination 

 

A third type of annotation is a confirmation. Someone examines a specimen and 
agrees with the determination. He prints an exclamation point (!) and his name or initials 
and the date. This exclamation point is placed above the label or above the latest change 
in determination or accepted name. In the data field for Annotation History, enter the 
confirmed name, the annotator’s name or initials and date. Use this format: 
"Maianthemum racemosum L. (confirmavit – J. Doe, March 6, 2008)". 

 
Record of Voucher 

 

If a specimen is a voucher or was examined and/or recorded for a scientific study or 
another database, enter the pertinent information (including a date) in this field. Also 
print the same information in pencil on the specimen sheet (or on an Annotation label), 
preferably on the bottom of the sheet adjacent to the label. 
 
20. Distribution or Loss of Specimens; including loans 
 

Use this section to account for the distribution and loss of specimens. For Distribution, 
enter where the specimen was sent and the date sent. Use this format: "Specimen 
transferred to the Clinton Herbarium (BUF), Buffalo Museum of Science, June 31, 
2005." For specimens consumed in the classroom, lost, discarded, or destroyed, use this 
format: "Specimen discarded 2008." Use specific verbs as appropriate. 

For loans, enter to whom the specimen was loaned, the dates of loan and the projected 
date of return. Include contact information. After the loan is returned, retain a record of to 
whom the specimen was loaned and the loan's inclusive dates; for example, "Specimen 
loaned to Clinton Herbarium (BUF), Buffalo Museum of Science, September 1, 2008- 
December 31, 2008." 
 
21. Comments: 
 

Enter any data, temporary or permanent, pertinent to the specimen or the record, that 
you wish to retain but do not wish to appear on the label. For example, comments on the 
condition of the specimen. 

 
Duplicate Collections 

 

A collector may collect multiple specimens of the same species at the same time and 
place. The "extra" collections are called duplicates. Duplicates share the same collection 
number and are not intended for the same herbarium. For the specimen retained in the 
Eckert Herbarium, in the data field for Notes, record the total number of duplicates and 
where each was sent. For example, "two duplicates – duplicate 1 to the Clinton 
Herbarium (BUF), duplicate 2 to the New York Botanical Garden (NY)." Until a 
duplicate is distributed, enter "duplicate 2 retained." In the record for each duplicate, 
enter in the data field for Notes: "DUPLICATE" or "DUPLICATE 1 of 2." 

 



 15 

Replace an Original Label 
 

As a general rule, you never write on the original label. An original label can be 
replaced if is damaged or is printed on non-archival paper. A collections manager will 
decide which labels to replace. Carefully remove the original label from the specimen 
sheet and retain it in the fragment envelope. Print the new label on archival paper using 
the label printing function of this program and glue it at the sight of the original label. 
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